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Materials overview

You manage your library’s material collection by editing, importing, and exporting
material records. Editing your material records database includes adding, changing, and
deleting individual records. You can also batch process material records, set up custom
indexes, and perform a global subject edit.

Setting up
You add records either by importing a file of records or by entering individual records.
However, before you add materials, you must set up your material types. While setting up
these types, you can also set up how call number patterns map to material types. This
process relates call numbers to material types, so that the program can determine material
types by analyzing the call number. This can save you data entry time. For more
information, see "Setting up material types" in the Setup chapter of this manual.

Backing up
Back up your database files before and after you make major changes or additions to your
records. For more on backups, see "Backing up Spectrum data" in the Backup chapter of
this manual.

About materials and holdings
Spectrum CIRC/CAT uses both material records and holding records.

Material versus holding
It can be easy to confuse the terms "material" and "holding"—as well as the related terms
"material data," "holding data," "material record," and "holding record."

"Material" refers to a library item in general, such as a book, periodical, filmstrip, and so
on. The material record contains information such as author and title that applies to every
copy of that item. "Holding" refers to a particular copy of a material. The holding record
contains information such as material number, material type, and price, that applies
specifically to a single copy of the material.
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Term Definition

Material A literary, audiovisual, art, or other work as a whole (such as Moby
Dick by Hermann Melville). Note: For cataloging purposes, you may
consider works in different mediums (such as a film and a book of the
same title and author) as different materials.

Holding One copy of a material in your collection (such as your library’s
paperback copy of Moby Dick with material number 19034—or your
hardcover copy with number 13458).

Material
data

The MARC 21 data of a material. This data is common to all copies
of the material (for example, title, author, subject, and so on).

Holding
data

The MARC 21 and Spectrum-specific data relating to an individual
holding. Holding data includes material number, inventory status, and
so on.

Material
record

All the bibliographic data describing a material.

Holding
record

All the data specific to one holding. The holding record does not
include title or author information, but is associated with a material
record, which does include that information.
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Choosing a task
The Material tasks include Edit, Quick Add, Import, Export, Batch Process, Custom
Indexes, and Global Subject edit. You choose tasks by clicking the Materials button on
the Navigator toolbar.

How to choose a task
Example scenario: You want to start the Material Import feature.

To choose a task
From the Navigator toolbar, click the Materials button and
choose Import.



Materials: Adding records with Quick Add 229
SCC5um1200kh

Adding records with Quick Add

The Quick Add feature provides a fast and simple way to enter new materials into your
Spectrum CIRC/CAT database. It is designed for entering only basic catalog information
and one holding. More detailed information must be added using the Material Edit
feature.

When should I use Quick Add?
Use Quick Add to enter basic catalog information for a new material. If you want to enter
additional material information or information for more than one holding, you must use
the Material Edit feature. You can easily switch from Quick Add to Material Edit.

Note: You cannot use Quick Add to edit existing records. To edit records use the Easy
Entry or Edit MARC features. For more information, see "Editing existing material
records" later in this chapter.

How to add a record with Quick Add

To add a record with Quick Add
1 In the Navigator toolbar, click the Materials button and choose

Quick Add. The Quick Add window opens.
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2 Enter the material and holding information into the appropriate
boxes in the Quick Add window.

3 When you have finished, click Save.

4 To catalog another material, click New. Otherwise, click Close
to close the Quick Add window.

If you need to enter more detailed information or more than one holding, save the record
and then click the Material Edit button. The information in the Quick Add window is
transferred to the Easy Entry window so that you can enter additional information.

Using authority control with Quick Add
Quick Add provides optional authority control for author, title, and subject information.
You can enter information into any of these fields by choosing the desired value from a
list of data already in the database. This helps you keep your entries consistent between
records.

How to use authority control with Quick Add
Example scenario: You want to enter the author Martin, Louise.

To use authority control with Quick Add
1 From the Quick Add window, in the Author box, type the first

few letters of the author’s name, in this case Mar.

2 Click Authority. The Select Authority Author window opens.

3 Scroll through the list in the Authorities box until you find the
name of the author you want to enter, in this case, Martin,
Louise.

4 Select the author name. Then click Select. The Select Authority
Author window closes and the author name you selected is
entered into the Quick Add window.

Note: If the item you want to enter, in this case an author’s name, is not already in the
database, it will not appear in the Select Authority window. If you cannot find the item
you want to enter, exit the Select Authority window by clicking Cancel. Then manually
type the item.
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Managing material records

You can add, edit and delete material records using the Material Edit feature.

Opening Material Edit

To open the Material Edit feature
From the Navigator toolbar, click the Materials button and
choose Edit. The Easy Entry window opens.

Opening the Material Edit windows
There are two different windows that you can use for adding and editing material records:
the Easy Entry window and the Edit MARC window. The Easy Entry window is useful
for people who do not want to deal with the MARC format during data entry and editing.
The Edit MARC window is useful for people who are familiar with the MARC standard.
It also provides options for adding fields and subfields not found in the Easy Entry
window.

Note: When adding or editing records, you can switch between the Easy Entry and Edit
MARC windows.

Opening the Easy Entry window
In the Easy Entry window, you add, edit, and delete material records in an easy-to-use
format using a template for different material categories. In this window, you don’t need
to be familiar with the MARC standard.
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To open the Easy Entry window
From the Navigator toolbar, click the Materials button and
choose Edit. The Easy Entry window opens.

Note: Press the Tab key to move to the next box, or press both the Shift and Tab keys
together to move to the previous box.

To open the Easy Entry window from Edit MARC
From the Edit MARC window, click the Show Easy Entry button.

For information about the Easy Entry window, see "About the Easy Entry window" in the
Materials chapter of the Spectrum CIRC/CAT Reference Manual.

Opening the Edit MARC window
The Edit MARC window lets you edit material information in the MARC 21 with 852
holdings format (formerly known as USMARC/852 Holdings Data format). You can add,
edit, or delete information located in any tag, indicator, or subfield of a material record.
Essentially, the window contains the structure for a MARC record. You simply provide
the record’s content.

Show Easy
Entry button
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To open the Edit MARC window
1 From the Navigator toolbar, click the Materials button and

choose Edit. The Easy Entry window opens.

2 Choose Edit MARC from the View menu, or click the Show
Edit MARC button.

Note: If you don’t have a mouse, you navigate through the record data by using the Tab
and Shift keys (Tab to move to the next box, Shift + Tab to move to the previous box).

Inserting an underscore
To insert an underscore ( _ ) anywhere in a MARC 21 record, you need to press Control
+ Shift + the underscore key, except when you’re adding subfields. The underscore is
displayed with a space following it to distinguish it from a subfield mark.

For information about the Edit MARC window, see "About the Edit MARC window" in
the Materials chapter of the Spectrum CIRC/CAT Reference Manual.

Show Edit
MARC
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Loading material records
Before you view, edit, or delete an existing record, you must load it into a Material Edit
window (Easy Entry or Edit MARC window). You can load a record by specifying its
position in the database or by searching for it.

Note: Before you load a record, you may want to check the index by which your records
are arranged. This is especially true if you are planning to load a record by specifying its
position. This is because the order that records are arranged will depend on the active
index. The active index is displayed at the bottom of the window. You can select a
different index from the Index menu.

How to load a record by specifying its position
You can use any of these buttons when specifying a record’s position.

Button name Button Description

First Record Displays the first material record in the database
(according to your current index).

Previous
Record

Displays the material record that immediately
precedes the current record.

Next Record Displays the material record that immediately
follows the current record.

Last Record Displays the last material record in the database
(according to your current index).
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Example scenario: You want to load the last record in the database when the database is
ordered by title.

To load a record by specifying its position
1 From the Navigator toolbar, click the Materials button and

choose Edit. The Easy Entry window opens.

2 From the Index menu, choose Title.

3 From the Record menu, choose Last or click the Last Record
button. The appropriate record is loaded.

How to load a record using the Look Up button
Example scenario: You want to load the record with an ISBN of 0590849131

To load a record by searching
1 From the Navigator toolbar, click the Materials button and

choose Edit. The Easy Entry window opens.

2 From the Index menu, choose ISBN.

3 From the Record menu, choose Look Up, or click the Look Up
Record button. The Look Up window opens.

4 In the Find ISBN box, type 0590849131.

5 Click OK. The record is loaded. If an exact match is not found,
you are informed and the next record is loaded (except when
you select Material Number as the index, you are informed that
a match cannot be found).

Note: You can use the same procedures to load records from the Edit MARC window.

Look Up Record
button
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Viewing card images
You can view material record data as it would appear on a traditional catalog card.

To display a card image
1 From the Navigator toolbar, click the Materials button and

choose Edit. The Easy Entry window opens.

2 Load the material record that you want to view. For
instructions, see "Loading material records" earlier in this
chapter.

3 Choose Card Image from the View menu, or click the Show
Card Image button. The Card Image window opens.

Note: You can also view card images from the Edit MARC window.

Show Card
Image button
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Adding new material records
You can add new material records to your database by:

• Adding the records manually (ideal for adding a small number of
records).

• Importing a file of records (ideal for adding many records). For more
information about importing, see "Importing material records" later in
this chapter.

Adding material records is a two-step process. First you add universal information, such
as title and author, in the Easy Entry or Edit MARC window. Then you add local
information, such as material number, material type, and shelving information, in the
Holdings window.

How to add a new material record manually

To add a new material record
1 From the Navigator toolbar, click the Materials button and

choose Edit. The Easy Entry window opens.

2 Choose New from the Record menu, or click the New Record
button. The default material record appears. (If you haven’t
saved a default record, the window contains no data. For help
creating a default record, see "Managing default records" later
in this chapter.)

3 Enter the data for the new record in the Easy Entry window or,
if you prefer, open the Edit MARC window and enter data
there.

4 Click the Show Holdings button and enter the holdings data.
You must add at least one holding. For instructions, see
"Adding holding records" later in this chapter.

5 Choose Save from the Record menu, or click the Save Record
button.

For a full description of Easy Entry and Edit MARC fields, see "Material and holding
fields” in the Material/Holding Fields appendix of the Spectrum CIRC/CAT Reference
Manual.

To add diacritics in Windows, hold down the Alt key while using the numeric keypad to
type the decimal value of the character you want. To add diacritics on a Macintosh, use
the Key Caps control panel.

New Record
button

Show Holdings
button

Save Record
button
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Editing existing material records
You can modify the information for an existing material record at any time. From either
the Easy Entry or Edit MARC window, simply load the record and make your changes.

How to edit an existing material record
Example scenario: You have previously cataloged and saved a material record. Now you
discover that some of the information you entered was incorrect. You decide to edit the
record to fix these inaccuracies.

To edit a material record
1 From the Navigator toolbar, click the Materials button and

choose Edit. The Easy Entry window opens.

2 Load the material record that you want to edit. For instructions,
see "Loading material records" earlier in this chapter.

3 Make your changes in the Easy Entry window or, if you prefer,
open the Edit MARC window and make your changes there.

4 When you have finished, click the Save Record button.

Duplicating existing material records
You can create a new material record based on the currently loaded material record.
When you duplicate an existing material record, the information from the current record
is copied to the new record and a new material number is assigned. The program also
creates a new holding for the new material record based on the selected holding in the
current record.

Note: This command is available only when you load an existing material record or
create and save a material record.

How to duplicate an existing material record
Example scenario: You are cataloging two items in a series. Only the publication date,
physical description, title, and notes are different between the two materials. To save
time, you have decided to create a record for the first material and duplicate it. Once
you’ve done this, you can edit the date, physical description, title and summary data to
reflect the second material.

Save Record
button
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To duplicate a material record
1 From the Navigator toolbar, click the Materials button and

choose Edit. The Easy Entry window opens.

2 Create and save a material record for the first material.

3 From the Record menu, choose Duplicate, or click the
Duplicate Record button. The program creates a new record.

4 Edit the information so that it reflects the second material. Note:
You can do this from either the Easy Edit or the Edit MARC
window.

5 Click the Show Holdings button and add or edit material
holdings for the record. For instructions, see "Adding holding
records" later in this chapter.

6 From the Record menu, choose Save, or click the Save Record
button.

Deleting material records
As you remove materials from your collection, you can remove the corresponding
material record from your database. The program will not allow you to delete a record
that currently has holdings circulating or holdings for which advanced reserves have been
placed. If you are in the process of editing a material record, you must first save it or
revert to the last saved version before deleting.

Note: When you delete a material record, all corresponding holdings records are also
deleted.

For records with multiple holdings you can delete individual holdings, rather than the
entire material record. For more information, see "Deleting holding records" later in this
chapter.

Save Record
button

Duplicate
Record button

Show Holdings
button
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How to delete a material record
Example scenario: You have weeded all copies of a particular material from your
collection. Now you want to delete its material record.

To delete a material record
1 From the Navigator toolbar, click the Materials button and

choose Edit. The Easy Entry window opens.

2 Load the material record you want to delete. For instructions,
see "Loading material records" earlier in this chapter.

3 Click the Delete Record button. If the record has only one
holding, you are asked if you’re sure you want to delete the
record. If the record has multiple holdings, you are asked if you
want to delete all copies of the record. If the material has
circulation activity, the program warns that you cannot delete
the material record.

4 Click Delete or Delete All to confirm. The record data remains
on screen, but the record’s holding(s) are deleted. After you
load another record, you cannot reload the deleted record’s
data.

Important! If you delete a record by mistake, you can recover it as long as it’s still
displayed. If you haven’t done anything else, the record you deleted is still visible in the
window. To recover the record, make a minor change to the data (for example, place your
cursor in any text field in the Easy Edit or Edit MARC window, delete one character, and
replace it with the same character). Then choose File > Save from the menu to put the
record back in the database.

Managing default records
A default record is a material or holding record containing data that the program uses as a
template when creating new material and holding records. When you create a new
material or holding record in Easy Entry or Edit MARC, the program automatically fills
in information for you based on the default record. This saves you data-entry time since
you do not need to enter this information yourself. The program allows you to have both
a default material record and a default holding record.

You can change this default information as necessary to meet the needs of your library.
For example, if all of your holdings have the same four-digit location code, you may
want to save the location code in the default holding record. When a default record is no
longer useful, you can delete it.

Delete Record
button
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Note: When using the Edit MARC window, you can enter holding information directly
into tag 852 of the default material record. However, if there is also a default holding
record, the information from the default holding record takes precedence over the holding
information in the default material record.

How to save a default material record
Example scenario: You are entering a number of books written by Louise Martin. You
want to create a default material record so that the correct author information is
automatically entered for you each time you create a new record.

To save a material record as default
1 From the Navigator toolbar, click the Materials button and

choose Edit. The Easy Entry window opens.

2 Choose Edit MARC from the View menu, or click the Show
Edit MARC button.

3 Edit the record to contain the data you want to use as default.
In this case, type Martin, Louise in subfield _a of tag 100 (Main
entry – personal name).

4 From the Record menu, choose Save as Default. You’re asked
if you want to save the record as a default material record.

5 Click Yes.

How to save a default holding record
Example scenario: You are entering a number of holdings purchased from the Friends
fund. You want to create a default holding record so that the correct fund information is
automatically entered for you each time you create a new holding record.

To save a holding record as default
1 From the Navigator toolbar, click the Materials button and

choose Edit. The Easy Entry window opens.

2 Choose Holdings from the View menu, or click the Show
Holdings button.

3 Edit the record to contain the data you want to use as the
default. In this case, type Friends in the Fund box.

4 From the Record menu, choose Save as Default.

Show Holdings
button
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How to delete the default material record
Example scenario: You want to delete the default material record, so that the program
does not enter default information for you when you create a new material record.

To delete the default material record
1 From the Navigator toolbar, click the Materials button and

choose Edit. The Easy Entry window opens.

2 Choose Edit MARC from the View menu, or click the Show
Edit MARC button.

3 Choose Delete Default from the Record menu.

4 Click Yes when asked if you want to delete the default material
record.

How to delete the default holding record
Example scenario: You want to delete the default holding record so that the program does
not enter default information for you when you create a new holding record.

To delete the default holding record
1 From the Navigator toolbar, click the Materials button and

choose Edit. The Easy Entry window opens.

2 Choose Holdings from the View menu, or click the Show
Holdings button.

3 From the Record menu, choose Delete Default.

4 Click Yes when asked if you want to delete the default holding
record.

Show Holdings
button
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Using authority control in material records
Local authority control helps you minimize spelling, capitalization, and punctuation
inconsistencies in your data by letting you choose values already used in your database.
Authority control also saves you time because you can select existing values rather than
typing them.

Local authority control is provided in the Easy Entry window for titles, authors (including
main entry and added entry authors), and subjects. For example, if you are adding a book
to your collection with the subject: aAlaska_xDescription and Travel., as long as this
subject already exists in your database, you can use authority control to select it from an
existing record.

How to use authority control in a material record
Example scenario: You want to use local authority control to enter the subject "_aLibrary
automation".

To use authority control in a material record
1 From the Navigator toolbar, click the Materials button and

choose Edit. The Easy Entry window opens.

2 Load or create a material record.

3 Click the Subject box.

4 Click the Authority Control button. The Select Authority
Subject window opens.

Authority
Control button
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5 In the Search for box, enter the first few letters of the value you
want to search for, in this case _alib. Or, use the scroll bar and
arrow keys to browse for the value.

6 In the Available authorities box, click the desired value, in this
case, _aLibrary automation.

7 Click Select. The words "Library automation" appear in the
Subject box.

Note: The Select Authority window displays the data as it currently exists in the
database—with no changes to the punctuation and capitalization and including all
subfields. However, the Select Authority window does not display titles, authors,
subjects, or call numbers over 150 characters in length.

Managing tags, subfields, and indicators in Edit
MARC
You can add, edit, and delete the tags, subfields, and indicators of a material record’s
MARC data.

While you’re editing, the program maintains correct structure for the MARC record while
you provide the content. Normally, text selections and commands in the Edit menu work
on a maximum of one tag at a time. The exception is when copying and pasting MARC
records. Then, these commands work on all selected tags.
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The following diagram shows the components in a typical MARC field:

100 10_a Branley, Franklyn Mansfield, _d1915- ^

tag number
(indicates
author)

indicators
(1 indicates
surname, 0
indicates
undefined)

subfield
(_a
indicates
personal
name)

subfield data subfield
(_d indicates
dates
associated
with a name)

subfield data end of tag
marker

About tags
A tag is a number that identifies a field of a material record in MARC 21 format. For
example, tag number 100 identifies the author of a material.

About subfields
In a MARC 21 record, a subfield divides the data in a field into more details. For
example, Publication, tag number 260, has several subfields:

• a – place of publication

• b – name of publisher

• c – date of publication

The material record may contain more subfields than are displayed in the Easy Entry
window. You edit or view subfields in the Edit MARC window.

About indicators
Indicators are one of two characters after the tag number in a MARC 21 record. A
MARC 21 record indicator usually impacts material record data in very specific ways.
For example, tag number 100 holds author data. The first indicator you choose
determines whether the actual author name entered is a forename (indicator value of 1),
single surname (indicator value of 2), multiple surname (indicator value of 3), or family
name (indicator value of 4). You do not have to choose a second indicator.
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Adding tags and subfields
You can insert new tags in a MARC record. You can also add new subfields to existing
tags. You do all of this from the Edit MARC window.

How to add a tag
Example scenario: You have already loaded a material record and displayed it in the Edit
MARC window. Now you want to add the tag 246 Varying form of title to the MARC
record.

To add a tag
1 In the Edit MARC tab, place your cursor in one of the following

places:

• Before an existing tag number to insert the new tag immediately
before the existing tag.

Position the
cursor before the
existing tag.

• At the end of the record to append the new tag to the end of the
record.

To append the
tag to the end of
the record,
position the
cursor at the
end of the
record.
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• Between two existing tag numbers (in Moderate or Full MARC
Expansion views only) to insert the new tag between the existing
tags.

To insert the tag
between two
existing tags,
position the
cursor between
the existing
tags.

2 Click the Insert MARC text button. The Tag Number window
opens.

3 Select tag 246 (r) Varying form of title from the Tag Number
window list.

4 Click OK. The Tag Number window closes and the tag is
inserted in the record.

If you are not using a mouse, you can place the insertion point just before a tag number or
between two tags, and then type the new tag number. When you press the Return key, the
program adds the new tag.

Insert MARC
text button
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How to add a subfield
Example scenario: You have already loaded a material record. Now you want to add
subfield e place of manufacture to tag 260.

To add a subfield
1 From the Edit MARC window, in tag 260, place the cursor in an

existing subfield or after the second indicator (if expansion is
set to None).

Position the
cursor in an
existing subfield.

2 Click the Insert MARC Text button. The Subfield window
opens and displays a list of valid subfields for that tag.

3 Select a subfield value, in this case e (n) Place of manufacture.

4 Click OK. The Subfield window closes and the subfield is
inserted in the record.

You can add a subfield using only the keyboard. Position the insertion point where you
want the subfield, and then type an underscore character.

Insert MARC
text button
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Note: You can insert a subfield wherever one is valid: after the second indicator, in the
middle of the tag, or at the end. (In moderate or full MARC expansion, to insert a
subfield between the second indicator and an existing subfield you need to temporarily
switch MARC Expansion to None.)

Editing indicator values, subfield codes, and tag numbers
From the Edit MARC window, you can change the value of subfield codes and
indicators.

How to edit an indicator or subfield
Example scenario: You have already loaded a material record. Now you want to change
the Indicator 1 value of tag 082 to 1.

To edit an indicator
1 In the Edit MARC window, select the current indicator 1 value

for tag 082.

Select the
current indicator
value.
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2 Click the Insert MARC Text button, or press Enter. The
Indicator window opens and displays a list of valid values for
that indicator or subfield.

3 Select 1 Abridged edition.

4 Click OK. The Indicator window closes and the value is inserted
in the record.

You can follow the same procedure to edit a subfield code. Just select the existing code,
click the Insert MARC Text button, and then choose the new subfield code from a list.

If you know the indicator value you want, you can type it rather than selecting it from a
list.

Note: All tags numbered 10 or higher have two indicator positions—you can’t insert or
remove individual indicator positions.

Insert MARC
text button
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How to edit a tag number
Example scenario: You have already loaded a material record. Now you want to change
tag number 100 to 110.

To edit a tag number
1 In the Edit MARC window, select the tag number you want to

change, in this case, 100.

Select the tag
number.

2 Click the Insert MARC Text button, or press Enter. The Tag
Number window opens.

3 Select the new tag number, in this case, 110 (n) Main entry –
corporate name.

4 Click OK.

If you know the tag number you want, you do not need to use the Insert MARC Text
button. You can select the existing tag number in the Edit MARC window and then type
the new number.

Deleting indicators
All tags numbered 10 or higher have two indicator positions. Although you can’t insert or
remove individual indicator positions, you can remove their values.

Insert MARC
text button
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How to delete an indicator
Example scenario: You have already loaded a material record. Now you want to remove
the value from the first indicator in tag 100.

To delete an indicator value
1 In the Edit MARC window, select the value for the first indicator

in tag 100. Note: If you are using Moderate or Full Expansion,
select just the value shown between the single quotation marks.
Although there may be descriptive text associated with this
value, this text does not need to be selected.

2 Press the Delete key on your keyboard

Deleting tags (and accompanying indicators and subfields)
When you delete a tag, all accompanying indicators and subfields are also deleted.

How to delete a tag
Example scenario: You have already loaded a material record. Now you want to delete
tag 740.

To delete a tag (and all accompanying indicators and subfields)
1 In the Edit MARC window, use your mouse to select the entire

tag, including all indicators and subfields.

2 Press the Delete key, or choose Clear from the Edit menu.

To select an entire tag when MARC Expansion is set to None, triple-click the line. If
MARC Expansion is set to Moderate or Full, select the tag number and both indicators—
the rest of the tag is selected automatically.
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Exceptions
You can add and edit most fields in Edit MARC. However, because of their unique
characteristics, some fields require special consideration.

Leader and control fields

The process for editing data in these fields is different than editing other fields. For more
information, see "Managing fixed-length fields" later in this chapter.

Local holding data—in general (tag 852)

You must add and delete holding records in the Holdings window. Although you can edit
local holding data through the Edit MARC window, you can’t add or delete a holding
record in Edit MARC. You can’t renumber a non-852 tag to 852 or change the 852 tag to
another number.

Local holding data—price (tag 852_9)

Although the price of a material is local holding information, you can add or edit the data
in either the Edit MARC window (at 852_9) or the Holdings window (in the Price box).

Local holding data—call number (tag 852_h)

The various parts of the call number can be stored in the following subfields: _k (prefix),
_h (classification part), _i (item part), and _m (suffix). However, when you enter the call
number in the Holdings window, the combined call number is displayed, with spaces
inserted between subfields in the _h subfield in the Edit MARC window. For example,
entering the call number field in Edit MARC preserves the _k, _h, _i, and _m subfields.
But as soon as you change the call number in the Holdings window, all the text is placed
in the _h subfield.

Local holding data—material number (tag 852_p)

For the material number, Spectrum CIRC/CAT accepts only characters in the 3 of 9
character set—including numbers, capital (not lowercase) letters, spaces, and select
symbols (such as % - . + / and $). You cannot enter invalid characters. Also, if you insert
an unacceptable character (by entering, pasting, or deleting part of a subfield), a window
alerts you that the invalid character(s) were deleted.
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URLs (tag 856_u)

Uniform Resource Locators (URLs) are the addresses for locations on the Internet (such
as http://www.sagebrushcorp.com). A material record can store this information in tag
856 (Electronic location and access) subfield _u. However, many URLs contain
underscores ( _ ), which don’t work well in a MARC record because they conflict with
the Pre-1987 MicroLIF format.

To get around this conflict, the characters %5F are stored in place of an underscore (the
MicroLIF standard interprets %5F as an underscore). When entering or editing a URL in
856_u, press Control + Shift + Underscore wherever you need to insert an underscore.
The window displays an underscore followed by a space to represent a single underscore,
and it is converted to and from %5F when the record is saved or loaded.

Note: Enter a URL in the material record if you want to be able to access its web site
from the Catalog part of the program using WebConnect. To enable WebConnect, you
must activate it in Catalog Setup.

Managing fixed-length fields
If you are familiar with the MARC format, you know that some fields, those with tag
numbers starting with 00, such as the leader (tag LDR) and control fields (tags 006, 007,
and 008) are special. This is because:

• The data stored in each of these fields is composed of several
elements. For example, the leader contains information about the
record length, the record status, the type of record, and so on.

• Each element has its own specific position within the field. For
example, the first five characters of the leader refer to the logical
record length, the sixth character refers to the record status, the
seventh character refers to the type of record, etc. These positions are
numbered starting from 0. For example, the second character is in
position 1, the third character is in position 2, and so on.

• Record length is fixed.

• Information in these fields is encoded. This means that although the
information is valid and important, it cannot easily be deciphered by
someone who is not familiar with the MARC standard.

These fields are called fixed-length fields.
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Identifying components within a fixed-length field
When MARC Expansion is set to Moderate or Full, the program provides you with
detailed information about the fixed-length fields. For each field, this includes:

• Description of the field. This tells you about the type of information
stored in a particular field.

• Position. This tells you the position in the field that is selected for
editing. It also tells you what type of information that position refers
to.

• Value. This tells you the current value stored in that position and what
that value signifies.

If MARC Expansion is set to Moderate or Full, to identify a component within a fixed-
length field, all you need do is select the component. The program will then display the
position and value information for that component. If MARC Expansion is set to None,
you can simply position the mouse pointer over the component to have the program
display both the name of the component and its value.

How to identify the components within a fixed-length field
Example scenario: You want to identify the component in position 1 of the 007 tag.

To identify a component in a fixed-length field when MARC Expansion is
set to Moderate or Full

1 Display the Edit MARC window for the desired record.

2 Click the first position in the field labeled 007 Physical
Description Fixed field. Notice that the position indicator
changes to show that you are at position 1 and that this
position represents the Specific material designation.2. The selected

position in the
field.

3. A description of the type of data
contained at the position.

4. The current
value and what
it stands for.

1. Select a
component in a
fixed-length
field’s data and
the program
displays
information
about that
component.
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When MARC Expansion is set to None, you can identify a component in a fixed-length
field by positioning the mouse pointer over it. A box appears telling you both the name of
the component and its value.

Editing fixed-length fields
Because each element in a control field must be encoded and entered into a specific
location within the field itself, entering data into these fields could be time-consuming.
Fortunately, the program makes this process easier by, wherever possible, providing you
with a list of values for a particular component within the field. You simply choose the
desired value from the list. The program encodes it and inserts it into the correct position
within the field.

How to edit a fixed-length field
Example scenario: You want to change the Specific mat designat component (position 1)
of the 007 tag to indicate Large Print.

To edit a fixed-length field
1 Display the Edit MARC window for the desired record.

2 In the 007 field, click the single character in position 1.

3 Click the Insert MARC Text button. A window opens showing
all the possible values for this component.

4 Click b Large print.

5 Click OK.

Note: In some cases, providing a list of values is not possible. In these situations, the
program provides a description of the component and gives you as much information as
possible to help you enter data.

Insert MARC
text button

Click on the character
in position one. Note
that positions are
numbered starting at
0 (zero).
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Copying and pasting MARC records
You can copy MARC records from outside sources. Not only does this save data entry
time, it also saves cataloging resources. Instead of cataloging a record yourself, you can
find an existing record on the Internet or from some other source and copy it into your
Spectrum CIRC/CAT database. Possible sources of MARC records include the Library of
Congress, other Spectrum CIRC/CAT systems, MARConnect, and Athena library
automation systems.

Before you can copy a MARC record, it must adhere to either the 1987 MicroLIF format
or the MARC 21/852 Holdings format. If the leader, tag 005, or tag 008 is missing, the
program creates it for you. If the incoming MARC record contains holding data in the
852 tag, this information is not copied into Spectrum CIRC/CAT.

How to copy and paste a MARC record
Example scenario: You want to copy a record from the Library of Congress web site into
Spectrum CIRC/CAT.

To copy a record from an outside source
1 Using your browser go to the Library of Congress web site

(http://lcweb.loc.gov/z3950/) and search for the record that
you want to copy.

2 Display the record in MARC format (the Library of Congress
calls this tagged display).

3 Using your mouse, select the entire record. Make sure that you
do not select information, such as a button, that is not part of
the MARC record.

4 Copy the selected information to the clipboard. (For help, refer
to the documentation that came with your operating system.) If
you like, you can exit your browser.

5 In the Spectrum CIRC/CAT Edit MARC window, display a blank
record by clicking the New Record button.

6 From the Edit menu, choose Select All.

7 From the Edit menu, choose Paste. The program copies the
new record into the Edit MARC window.

8 Edit the record as necessary and add holdings information.
When you have finished, save the record.

New Record
button
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Note: This feature is intended to save time by copying the bulk of the MARC record data.
However, since it has to be flexible enough to handle a variety of formats, depending on
the MARC record source, the program may not always make a perfect copy of the data.
Always do at least a quick check to make sure the data copied correctly, especially
control tags and indicator values.

Some sources of MARC records do not display subfield codes. This can cause problems
when the program copies the record into the Spectrum CIRC/CAT database. Problems
range from not being able to paste the record into the Spectrum CIRC/CAT database to
incorrect display of subfield data. After copying a record from a source that does not
display subfield codes, pay special attention to subfield data. You may need to edit it
before saving the record.

For optimum results when copying leader and control tags, the source record should be in
the communications format. Some sites offer this format.

Problems?
Here is a list of common problems and suggestions for solving them.

Tag 008 from Athena records does not copy properly. Before selecting the record in
Athena, make sure that the Athena window is wide enough that the tag can display on
one line.

Tag 001, leading spaces removed. After pasting the record into Edit MARC, edit the tag
to re-insert the leading spaces.

Problem copying records that contain URLs with underscore characters. If the
record adheres to a 1987 MicroLIF type format, copy the record to a word processor,
such as WordPad or SimpleText, and replace each underscore with "%5". This will not
work with formats other than 1987 MicroLIF.
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Customizing the Edit MARC window
You can customize the Edit MARC window by specifying the amount of supporting
information displayed as well as the way this information is displayed.

Customizing the amount of information shown
The MARC Expansion command in the View menu lets you display the material record’s
MARC data with varying amounts of supporting information: None, Moderate, and Full.
The following table provides examples of all three MARC expansion settings.

Setting Description Example

None Displays all of a field’s
data on one line (fields
with a lot of data may
wrap onto additional
lines).

10010_aKepler, Harry Leonard,_d1893-1957.

Moderate Displays all of a field’s
data on separate
lines—including the
descriptions of tag
numbers and subfield
codes.

100 Main entry - personal name
         ' 1 '   Surname
         ' 0 '
      _a           Personal name
         ' Kepler, Harry Leonard, '
      _d           Dates associated with a name
         ' 1893-1957. '

Full Displays all of a field’s
data on separate
lines—including the
descriptions of tag
numbers, subfield
codes, and the
identifiers Tag,
Indicator, and Subfield
in front of each
element.

Tag 100 Main entry - personal name
          Indicator 1:   Type of personal name
entry element
          ' 1 '   Surname
          Indicator 2:
          ' 0 '
      Subfield: _a   Personal name
          ' Kepler, Harry Leonard, '
      Subfield: _d   Dates associated with a name
          ' 1893-1957. '
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How to specify the amount of information shown
Example scenario: When viewing a MARC record, you want to view the maximum
amount of supporting information.

To specify the amount of information shown
With the Edit MARC window open, choose MARC Expansion
from the View menu. Then select the type of expansion desired,
in this case, Full.

Choosing a font
The Font command lets you set the characteristics of the text that appears in the Edit
MARC window. When you choose Font, a window opens where you specify the font and
point size of the window text.

Note: This feature is not available in this version of Spectrum CIRC/CAT.

How to choose a font
Example scenario: You want to change the font to Courier 16 point.

To customize the font
1 With the Edit MARC window open, choose Font from the View

menu. The font window appears.

2 From the Font list, select the appropriate font, in this case
Courier.

3 In the Sizes list, select the desired size, in this case 16.

4 Preview the font in the Sample box.

5 Click OK.

Note: Changing the value in the Font style list of the Font window, affects only the
supporting information such as field names. It does not affect the display of information
entered into the various fields.
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Displaying supporting information
The Bold/Italic command lets you determine how a record’s supporting information is
displayed. Supporting information includes the descriptions (names) of fields, subfields,
and indicators that help identify the different elements of the record. You can either bold
or italicize this text, thus distinguishing it from the record’s MARC data. Note: This
command is available only when MARC Expansion is set to Moderate or Full.

How to change the supporting information display

To change the appearance of supporting information
With the Edit MARC window open, choose Bold/Italic from the
View menu.
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Managing holdings

Managing holdings consists of adding, editing, and delete holding data.

About materials and holdings in Spectrum
In Spectrum CIRC/CAT, the term "material" refers to a library item in general, such as a
book, periodical, filmstrip, and so on. The term "holding" refers to a particular copy of a
material. In Spectrum CIRC/CAT, a material record must have at least one holding
associated with it. When you delete a material record’s only holding, you also delete the
material record from the database.

Accessing holding records
Because each holding record is connected to a material record, you must first display the
material record before you display its holding record(s). After you display a record (in
either the Easy Entry or Edit MARC window), you can then access its holding data.

How to access a holding record

To access a holding record
1 From the Navigator toolbar, click the Materials button and

choose Edit. The Easy Entry window opens.

2 Load the material record for the holding that you want to
access. For instructions, see "Loading material records" earlier in
this chapter.

3 Click the Show Holdings button. The Holdings window opens.
Notice that all holdings are listed in the box at the bottom of
the window. To view information for a particular holding, click
it.

Show Holdings
button
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This part of the
window shows
detailed information
about the holding
selected below

Select a holding. The
program displays
detailed information
about the selected
holding in the top
portion of the
window.

Note: When the Holdings window is active, all "record" functions apply only to the
holdings for the currently loaded material record. You cannot load another MARC record
from the Holdings window.

Adding holding records
You can add holding records one at a time or in groups.

Note: When adding large numbers of holdings on a Macintosh, no more than 200
holdings should be added to a single material record. Holdings in excess of this number
may result in display errors and/or an unstable system.
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How to add a single holding record
Follow these instructions to add a single holding record to a material record.

To add a single holding record
1 From the Navigator toolbar, click the Materials button and

choose Edit. The Easy Entry window opens.

2 Create or load a material record. For help, see "Loading material
records" or "Adding new material records" earlier in this
chapter.

3 Click the Show Holdings button. The Holdings window opens.

4 To add a holdings record, choose New from the Record menu,
or click the New Record button.

5 Enter the information for the new holding.

6 Click the Save Record button.

After you enter and save the first holding record, you can add multiple holdings to the
same material by clicking the Add Holdings button. For more information, see "How to
add multiple holding records".

How to add multiple holding records
Use this method when you want to enter several holding records with similar information.

Example scenario: You want to create two additional holdings for an existing material
record. At present the record contains only one holding. Most of the information for the
two new holdings is identical to that of the existing holding. You do not want the
program to increment volume numbers when creating the new holding records.

To add a group of holding records
1 From the Navigator toolbar, click the Materials button and

choose Edit. The Easy Entry window opens.

2 Load the material record for which you want to add new
holdings. For help, see "Loading material records" earlier in this
chapter.

3 Click the Show Holdings button.

4 In the Holdings window, select the holding you want to base
the new holdings on.

Show Holdings
button

Show Holdings
button

Save Record
button

New Record
button
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5 Click the Add Holdings button. The Add Holdings window
opens.

6 Enter the number of holdings to add, in this case 2.

7 Do not select the Increment the volume number option.

8 Click Add. The window displays the number of holdings added.

9 When processing is complete, click Close.

If new holdings differ slightly from the original holding, or from each other, you will
need to edit the records slightly. You can do this in the Holdings window. Remember to
save the records after editing them. For information about the Add Holdings window, see
"About the Add Holdings window" in the Materials chapter of the Spectrum CIRC/CAT
Reference Manual.

Add Holdings
button
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Editing holding records
You can make changes to a holding record at any time, even if the holding is currently
circulating.

Note: If a holding is on Special Reserve, you can’t change the material type.

How to edit a holding record
Example scenario: You have relocated a particular holding from the staff library to the
main library. Now you want to edit its holding record to reflect this change.

To edit a holding
1 From the Navigator toolbar, click the Materials button and

choose Edit. The Easy Entry window opens.

2 Load the material record for the holding that you want to edit.
For instructions, see "Loading material records" earlier in this
chapter.

3 Click the Show Holdings button. the Holdings window opens.

4 If there are multiple holding records in the box at the bottom of
the window, click the holding that you want to edit.

5 In the Shelving location box, replace the existing text with
main library.

6 Click the Save Record button.

Deleting holding records
For a given material record, you can delete a single holding or multiple holdings.

Note: Since every material record must have at least one holding, when you delete the
only holding of a material record, the program also deletes the material record. Also, if a
holding is checked out or has fines, messages, advance reserves, or is on special reserve,
you can’t delete it.

For information about the Delete Holdings window, see "About the Delete Holdings
window" in the Materials chapter of the Spectrum CIRC/CAT Reference Manual.

Show Holdings
button

Save Record
button
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How to delete a holding record
Use this method when you want to delete only one holding record for a given material.

Example scenario: A particular material has four holdings. The material numbers are 500,
501, 502, and 503 respectively. You want to delete only holding 501.

To delete a single material holding record
1 From the Navigator toolbar, click the Materials button and

choose Edit. The Easy Entry window opens.

2 Load the material record for the holding that you want to
delete. For instructions, see "Loading material records" earlier in
this chapter.

3 Click the Show Holdings button. The Holdings window opens.

4 In the box at the bottom of the window, click holding 501.

5 From the Record menu, click Delete, or click the Delete
Record button. An alert window opens asking you to confirm
the deletion.

6 Click Delete, or if you are deleting the only holding, Delete
MARC.

How to delete multiple holding records
Use this method when you want to delete more than one holding record for a given
material.

Example scenario: A particular material has four holdings. The material numbers are 500,
501, 502, and 503 respectively. You want to delete only holdings 501–503.

To delete multiple material holding records
1 From the Navigator toolbar, click the Materials button and

choose Edit. The Easy Entry window opens.

2 Load the material record for the holdings that you want to
delete. For instructions, see "Loading material records" earlier in
this chapter.

3 Click the Show Holdings button.

Show Holdings
button

Show Holdings
button

Delete Record
button
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4 From the Material menu, choose Delete Holdings, or click the
Delete Holdings button. The Delete Holdings window opens.

5 In the from material number box, type 501. In the to material
number box, type 503.

6 Click Delete. The window displays the number of holdings
deleted and the number not deleted because they don’t have
the circulation status of "in".

7 Click Close.

Assigning material numbers to holdings
You can select and assign numbers to new holding records in several ways:

• Using the number already entered by the program. When you first
open the Holdings window, you see a material number in the material
number field. You can keep this number and start entering data for the
new record.

• Entering another number. You can assign any number to the new
record by typing the number in the Material number field. (If you set
up partitions, the number you enter must be within the material range.
See "Setting your location's number options" in the Setup chapter of
this manual. If the number you enter has already been assigned to a
material record, you’re prompted to enter an available number.

• Setting an automatic number. You can set the material number with
the Set Next Number menu item. This feature helps you find the
lowest available material number within a particular range.

Delete Holdings
button
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For information about the Next Material Number window, see "About the Next Material
Number window" in the Materials chapter of the Spectrum CIRC/CAT Reference
Manual.

How to find the lowest available material number
Example scenario: You want to find the lowest available number that is greater than 500.

To find the lowest available material number within a range
1 In the Holdings window, choose Set Next Number from the

Material menu. The Next Material Number window opens.

2 In the Next material number to use box, type 500.

3 Click Find. The next lowest available material number is
displayed in the Next number to use box.

4 Click OK. The number is loaded in the Use Number: menu
option of the Material menu. The next time you add a holding,
the program will assign it this material number.
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Assigning material types to holdings
When adding holding information, you can:

• Enter a material type number in the Material type box of the Holdings
window.

• Click the "Set Material Type" button and choose a material type from
in the Type Number window.

• Enter a call number in the Local call number box and then press the
Tab key. If the Material type box is empty and this is the first time that
you have entered a call number for this record, the appropriate type
number appears in the type box according to the call number patterns
you set in the Material Types Setup window. For help setting up call
number patterns, see "Managing call number patterns" in the Setup
chapter of this manual. Note: This method works only if the "Material
type" box is empty. Also, if the call number you enter doesn’t match
any call number patterns, the program will assign the default material
type to the holding.

How to assign a material type by choosing it from a list
Example scenario: You want to assign type number 5-Easy to a holding.

To assign a material type
1 In the Holdings window, place your cursor in the Material type

box.

2 Choose Set Material Type from the Material menu, or click
the Set Material Type button. The Type Number window
opens.

Set Material Type
button
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3 Choose a type, in this case 5-Easy, and click OK. The Holdings
window opens and the type number you chose is placed in the
Material type box.

Entering price information
You add or edit a holding’s price information in either the Edit MARC window (in tag
852 subfield _9) or the Holdings window (in the Price box). However, these two places
accept and display price data differently.

What you can enter
In the Edit MARC window, you can enter digits, plus letters or a symbol to indicate the
currency (such as $ or "usd" for U.S. dollars). In the Holdings window, you can enter
only digits (0–9) in the price field, but no letters or symbols. The maximum practical
value is 9999999.99—or a number up to 10 characters long—including the decimal point.
(The actual maximum is slightly higher, but does not include all 11-character numbers.)

Adding/deleting the price
When you enter price data in the Holdings window, the tag 852 _9 is created with the
price value in it, but with no other text. If you remove all numbers from the Holding
window’s price field, the _9 subfield is deleted if no other data (text or a second value)
exists.

Decimal point
Digits after the hundredth place are ignored, so 1.23456 is displayed as 1.23. Also, only
the first decimal place is recognized, so the value 2..9 is read as 2.00.

Multiple values
Your MARC data can contain multiple values in the _9 subfield (for example, "p13.45
usd, 15.65 Canadian"). However, the Holdings window displays only the first value
("13.45"—up to seven numbers before, and two numbers after, the first decimal point).
To display the second value, switch the first and second values in Edit MARC ("15.65
Canadian, p13.45 usd"). Likewise, if you edit the value shown in the Holdings window,
only the first value in the _9 subfield is edited.
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Importing material records

Rather than adding each new material and holding to Spectrum CIRC/CAT individually,
you can add material records to your collection by importing them from a file. For
example, if you receive a file of material records from a book vendor, you can import the
records to make them part of your Spectrum CIRC/CAT collection. Note: Be sure to set
up your material types and call number patterns before importing records.

Importing material records can take a lot of time. As an estimate, your records should
import at a rate of three to seven records per minute, depending on the size of the records,
the size of your existing material collection, the speed of your computer, and the options
you select for importing. Building key words and replacing records takes even more time.

Note: When adding large numbers of holdings on a Macintosh, no more than 200
holdings should be added to a single material record. Holdings in excess of this number
may result in display errors and/or an unstable system.

Note: Make sure that Power Management is not turned on while you import from a client
computer to the server. Otherwise, if Power Management shuts down your client
computer during the import process, your database might become corrupt. You can
access Power Management through the Control Panel. While you import, you should also
turn off any other program that shuts down or suspends activity on your computer.

Backing up
Back up your database files before and after you import records. For more on backups,
see "Backing up Spectrum data" in the Backup chapter of this manual.
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Opening Material Import
To open Material Import

From the Navigator toolbar, click the Materials button and
choose Import.

The Material Import window opens.

For information about the Material Import window, see "About the Material Import
window" in the Materials chapter of the Spectrum CIRC/CAT Reference Manual.
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The import process
Importing consists of three steps: selecting files, specifying import options, and starting
the import.

If the records you are importing contain diacritics, you should also refer to the topic
"Importing records with diacritics".

Step 1: Selecting files to import
Before importing, you need to specify which file(s) contain the records that you want to
import. You do this from the Material Import window.

Note: Files from book vendors are typically named MicroLIF.001. (Vendors may also
provide a .vol or .fil file, but you do not have to select these.) If you are importing records
from several files with the same name, rename the files so that they have different names.
For example, you might want to use Microlif.001, Microlif.002, Microlif.003, and so on.

How to select the file(s) for importing
Example scenario: You want to import the records contained in a file called microlif.001.

To select the file(s) for import
1 In the Material Import window, click the Add button. A system

window opens where you can locate the file you want.

2 Select the file to add, in this case microlif.001, and click Open.
The system window closes and the file is added to the Files to
import list in the Material Import window.

Importing more than one file at a time
You can import records from multiple files into Spectrum CIRC/CAT’s material
database.

Note: If you have added multiple files to the Material Import window, the program
imports all files, not just the selected (highlighted) file.

If you’re running Spectrum CIRC/CAT in Mac OS, you can add only one file at a time to
the list of files to be imported. That is because the dialog box of this operating system
allows only one file to be selected. So, to import more than one file, you need to repeat
the above steps for each file.
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Step 2: Specifying import options
Import options ensure that records are brought into your Spectrum CIRC/CAT database
properly. Among other things, import options tell the program how to determine if an
incoming record matches a record already in your database and what action should be
taken if a match does occur. You can also use import options to specify whether key
words should be built from the incoming records.

There are two types of import options: material import options and holdings import
options. For a full description of material import options, refer to "About the Materials
tab" in the Spectrum CIRC/CAT Reference Manual. For a full description of holdings
import options, refer to "About the Holdings tab" in the Spectrum CIRC/CAT Reference
Manual.

Note: After you set import options, the program retains your settings. You need to re-
specify import options only if you want to change them between imports.

How to set import options
Here are general instructions for setting import options. For specific examples, refer to
"Examples".

To set import options
1 In the Material Import window, click the Change button. The

Material Import Options window opens.
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2 In the Materials tab, set the respective material options. For a
detailed description of the various options, see "About the
Materials tab" in the Materials chapter of the Spectrum CIRC/CAT
Reference Manual".

3 Click the Holdings tab and set the respective options. For a
detailed description of the various options, see "About the
Holdings tab" in the Materials chapter of the Spectrum CIRC/CAT
Reference Manual.

4 Click OK. The program returns you to the Material Import
window.
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Examples
The import options you choose depend on how you want to import your records. Here are
three examples showing how various setups can produce different outcomes.

Example 1: How to import new records without matching

records
Example scenario: You are importing records and want to add each incoming record to
your database as a new record without checking to see if it matches an existing record.
(Follow this scenario if you’re importing records from a Winnebago CIRC/CAT for MS-
DOS program and want your records to appear the same in Spectrum CIRC/CAT as they
did in your old program.)

To import new records without matching any records
1 In the Material Import window, click Change. The Materials

tab of the Material Import Options window opens.

2 In the Materials tab, make sure the Replace database MARC
records with incoming MARC records option is not selected.

3 In the MARC record matching group, make sure that Do not
match MARC records is selected.

4 Click the Holdings tab.

5 Make sure the Add holdings option is selected.

6 Make sure the Import user-defined data from 961 tags option
is selected (when present)

7 Select Use the incoming material number.

8 In the Starting material number box, enter a number you
know is unused (for example, if your highest material number is
10000, use 20000).

9 Click the Change button and select Use the alternate source
settings. Then click OK to exit the Matching Number
Resolution window.

10 Click OK and continue importing.
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Example 2: How to add new holdings to existing records
Example scenario: You are importing records. If an incoming record already exists in
your database, you do not want to create a new material record. Instead, you want to add
new holdings to the existing record.

To add new holdings and merge with existing records
1 In the Material Import window, click Change. The Materials

tab of the Material Import Options window opens.

2 In the Materials tab, make sure the Replace database MARC
records with incoming MARC records option is not selected.

3 In the MARC record matching group, select Match MARC
records using the following criteria. Select at least one
matching option.

4 Click the Holdings tab and make sure the Add holdings option
is selected.

5 Select Use the incoming material number.

6 In the Starting material number box, enter a number you
know is unused (for example, if your highest material number is
10000, use 20000).

7 Click Change and select Use alternate source settings. Then
click OK to exit the Matching Number Resolution window.

8 Click OK and continue importing.
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Example 3: How to replace minimal records with cataloged

records
Example scenario: Some of the records in your current database contain only minimal
catalog information. You want to update these brief records with the more complete
MARC records that you have obtained from an outside source. In other words, you want
to import the new records and use them to replace your minimal records in your database.

To replace minimal records with catalogued records
1 In the Material Import window, click Change. The Materials

tab of the Material Import Options window opens.

2 In the Materials tab, make sure the Replace database MARC
records with incoming MARC records option is selected.

3 In the MARC record matching group, select Match MARC
records using the following criteria. Select at least one
matching option. (Select a field that has the same data in both
records.)

4 Click the Holdings tab and make sure the Add holdings option
is not selected.

5 Click Change and select Replace the existing holding data
with the incoming data. Then click OK to exit the Matching
Number Resolution window.

6 Click OK and continue importing.

Step 3: Starting the import
After you have identified the file(s) that you want to import and specified your import
options, you can start the import process.

To start importing
From the Materials Import window, click Import. The program
scans incoming files for diacritics. If any are found, the Diacritics
window opens so that you can identify the correct code page. For
help identifying the code page, see "Importing records with
diacritics" later in this chapter.

A window opens and informs you when the import is complete.
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Pausing and stopping the import
While the program is importing, you can temporarily pause or permanently stop the
process.

Note: After you stop the process, you can’t begin importing records from the last record
imported. When you restart the import, the program processes the entire file. To avoid
duplicate records when re-importing a file that you have "stopped", select the "Replace
database MARC records with incoming MARC records" import option. You may also
want to delete records imported between the time you started the import and the time you
stopped it. One option is to delete records based on date added, assuming you haven’t
added any other records that day. You can do this using the Batch Processing feature (set
a condition that Date added is equal to your import date). For more information, refer to
"Batch processing material records" later in this chapter.

How to pause and stop the import

To pause the import
In the Material Import window, click Pause. The program
temporarily halts the import. (Click Import to resume importing.
The program starts at the record it was at when you clicked
Pause.)

To stop the import (and remain in Material Import)
1 In the Material Import window, click Pause.

2 Click Stop. The program stops importing records but keeps the
Material Import window open. Note: Records processed by the
program prior to stopping, are imported.

Importing records with diacritics
Some records may contain non-standard characters. Often these are accented characters
such as ñ, à, and ç. These accents, called diacritics, are common in non-English words.

Computers use something called code pages to display diacritics and other characters.
When importing records that contain diacritics, you need to make certain that the
program is using the code page that corresponds to the diacritics within the records.
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During an import, the program scans the import file for diacritics. If any are found, the
Diacritics window opens. You can use this window to identify the correct code page. This
is a fairly simple process; it involves previewing diacritics using a series of different code
pages until you find the code page for which the diacritics are displayed properly.

If you know the incoming records use either a Windows code page or the MARC 21 code
page, use a Windows machine for the import. If you know the incoming records use a
Macintosh code page, use a Macintosh machine for the import.

For additional information about diacritics, see “About diacritics” in the Diacritics
appendix of your Spectrum CIRC/CAT Reference Manual.

How to identify the correct code page
Example scenario: You are importing records that contain diacritics. After starting the
import, the Diacritics window opens telling you that diacritics were detected in the
incoming records. Now you must identify the correct code page.

Code page list
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To select the correct code page
1 In the Diacritics window, open the code page list, and choose a

code page.

2 In the Diacritics window, look at the sample text in the box at
the bottom of the screen. If the diacritics are displayed
correctly, the program has identified the correct code page.

3 If the diacritics are not displayed correctly, open the code page
list, and choose a different code page. Continue trying different
code pages until the diacritics are displayed correctly.

4 Click OK.

If multiple code pages are used in the same import file, you cannot identify a single code
page. In this situation, select Auto-detect from the code page list. This instructs the
program to try and find the correct code page on a record-by-record basis.

Note: Depending on your operating system, it may not be possible to display certain
characters. Characters that cannot be displayed by your operating system are shown as
vertical bars.

After importing
When the import process is complete, an information window opens and shows the
number of records that were added to the database and the number of records that weren’t
added. To view errors that occurred when importing materials, click the View File button
in the information window. This opens the m_import.log file.

If you encounter errors while importing, refer to the topic "Addressing import errors".

Addressing import errors
The program reports problems with records being imported both during and after the
import process. You should address all errors either while importing or after importing,
as appropriate. Errors that can’t be automatically corrected by the program or addressed
by you during importing are recorded in a log, or error, file. After you finish importing,
you can check the contents of this log. You should also check the records listed in the file
thoroughly. If data in any of the imported material records is missing or incorrect, add or
edit the material record.

For information about specific error messages, refer to "Material Import troubleshooting"
in the Troubleshooting appendix of the Spectrum CIRC/CAT Reference Manual.
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How to open the m_import.log file immediately after the

import process
After importing, the program displays information about the number of records that were
imported, the number of records that were not imported, and so on. Any errors are listed
in the m_import.log file.

To open the m_import.log file immediately after the import process
When the import is finished, the program displays a Material
Import status window providing information about the import. If
the import process generates errors, this window contains a View
File button. To open the log, click the View File button.

How to open the m_import.log file after closing the Material

Import status window
You can view import errors even after closing the Material Import status window.

To open the m_import.log file (Windows)
1 Click the Start menu in the Windows desktop.

2 Click Find.

3 Click Files or Folders. A "Find: All Files" window opens.

4 Enter m_import.log in the Named box.

5 Choose the drive to search by clicking the arrow beside the
Look in box.

6 Click Find Now.

7 Double-click the m_import.log file listed at the bottom of the
Find window.

8 If computer prompts with an option to open the file, choose
Notepad. The m_import.log file opens.

To view the log,
click the View
File button.
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To open the m_import.log file (Macintosh)
1 Double-click the Hard Disk icon.

2 Open the folder containing your Spectrum system files. (By
default this is either "Winnebago Spectrum Client" or
"Winnebago Spectrum").

3 Locate the m_import.log file.

4 Double-click the file to open it.

5 The log file opens in a word processing program such as
SimpleText so you can view the errors.
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Exporting material records

You can copy material records from your database by exporting them to a file. You may
want to export material records to another program. You may even want to export
material records that you are about to delete. This way, you’ll have a copy that you can
easily re-import should it be necessary.

Note: If you have Windows 98 on your client computer, make sure that Power
Management is not turned on while you export from a client computer to the server.
Otherwise, if Power Management shuts down your client computer during the export
process, your database could become corrupt. You can access Power Management
through the Control Panel. While you export, you should also turn off any other program,
such as a screen saver, that shuts down or suspends activity on your computer.

Opening Material Export
To open Material Export

From the Navigator toolbar, click the Materials button and
choose Export.
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The Material Export window opens.

For information about the Material Export window, see "About the Material Export
window" in the Materials chapter of the Spectrum CIRC/CAT Reference Manual.

Exporting materials individually
You can export materials individually by specifying their material numbers.

How to export materials individually
Example scenario: You want to export the material with material number 505.
Furthermore, you want the exported record to be in the 1987 MicroLIF format and in a
file called export.001.
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To export materials individually
1 From the Navigator toolbar, click the Materials button and

choose Export. The Material Export window opens.

2 In the Export box, choose Materials Individually.

3 For Format, select 1987 MicroLIF.

4 In the Index box, enter the material number of the record that
you want to export. In this case, enter 505.

5 In the Output file box, type the name of the file that you want
to export to. In this case, type export.001. If you do not specify
a folder, the program places the export file in the same folder
as your Spectrum client (or single-user) system files.

Or, click Browse to select an existing file from a list.

6 Click Export.

Note: During an export the program logs error messages in a file called m_export.log.
After starting the export, you may see a message stating that the log file already exists.
You can append to the existing log by selecting Append. Or, you can overwrite existing
log entries by selecting Overwrite.

You can add additional records to this same file. Just repeat steps 4 and 6 for each record
that you want to export.

Exporting a range of materials
You can specify a range of materials and have the program export all materials that fall
within that range. The arrangement of records within the export file depends on the type
of range you select. For example, if you select a range of material type, items are ordered
by material type.

How to export a range of materials
Example scenario: You want to export all materials with a material type of 1, 2, or 3.
Furthermore, you want the exported records to be in the 1987 MicroLIF format, and you
want to place the exported records into a file called export.002.
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To export materials in a range
1 From the Navigator toolbar, click the Materials button and

choose Export. The Material Export window opens.

2 From the Export box, select Materials Within a Given Range.

3 Select the format of the materials to be exported. In this case,
select 1987 MicroLIF.

4 In the Index box, choose the index that you want to use to
specify the range. In this case, choose Material Type.

5 In the Start at box, type the starting value of the export range.
In this case, type 1.

Note: If you selected a custom index, click Change Custom
Index Range to change the range. For more information, see
"Using a material custom index range" later in this chapter.

6 In the End at box, type the ending value of the export range. In
this case, type 3.

7 In the Output file box, type the name of the file that you want
to export to. In this case, type export.002. If you do not specify
a folder, the program places the export file in the same folder
as your Spectrum client (or single-user) system files.

Or, click Browse to select an existing the file from a list.

8 Click Export.

Note: During an export the program logs error messages in a file called m_export.log.
After starting the export, you may see a message stating that the log file already exists.
You can append to the existing log by selecting Append. Or, you can overwrite existing
log entries by selecting Overwrite.

For information about the Material Export window, see "About the Material Export
window" in the Materials chapter of the Spectrum CIRC/CAT Reference Manual.



Materials: Exporting material records 289
SCC5um1200kh

Exporting all materials
You can export all materials in MARC file order. MARC file order means that the
exported records appear in the export file in the same order that they appear in the
Spectrum database.

How to export all materials
Example scenario: You want to export all materials and have records in the export file
sorted in the same order that they are in the Spectrum database. Furthermore, you want
the exported records to be in the 1987 MicroLIF format, and you want to place the
exported records into a file called export.003.

To export all materials
1 From the Navigator toolbar, click the Materials button and

choose Export. The Material Export window opens.

2 From the Export box, choose All Materials (in MARC File
Order).

3 For Format, select the format of the materials to be exported. In
this case, select 1987 MicroLIF.

4 In the Output file box, type the name of the file that you want
to export to. In this case, type export.003. If you do not specify
a folder, the program places the export file in the same folder
as your Spectrum client (or single-user) system files.

Or, click Browse and select an existing file from a list.

5 Click Export.

If you want to export all records, but need them arranged in an order other than MARC
file order, choose "Export Materials Within a Given Range" option in the Export box.
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Using a material custom index range
When you select "Materials Within a Given Range" from the Export box, you can use a
custom index to set the export range. Before you select a custom index, you must create it
in the Material Custom Indexes part of the program. For more information about creating
a material custom index, see "Creating material custom indexes" later in this chapter.

Because you can have up to three data fields in one custom index, you set a range for
custom indexes using the Custom Index Range Selection window instead of using the
Start at and End at boxes in the Material Export window. The Custom Index Range
Selection window is only available after you select a custom index in the Index box. The
custom index(es) display the index name you assigned in Material Custom Indexes.

For information about the Custom Index Range Selection window, see "About the
Custom Index Range Selection window" in the Materials chapter of the Spectrum
CIRC/CAT Reference Manual.

How to specify a range using a custom index
Example scenario: You have already created a custom index called AUTHOR BY DATE
EDITED which is based first on MARC Date Edited, and secondly on Author. Now you
want to export a range of records from your database using this index. You want to
export all records edited between 7/11/2000 and 9/25/2000 that have author names
starting with a letter from A to D.

To open the Custom Index Range Selection window and set a range
1 From the Material Export window, in the Export box, choose

Materials Within a Given Range.

2 In the Index box, choose the desired custom index. In this case,
AUTHOR BY DATE EDITED. Note: Before you can do this, the
AUTHOR BY DATE EDITED custom index must already be set
up.
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3 Click the Change Custom Index Range button. The Custom
Index Range Selection window opens.

4 The window contains a box for each field in the custom index.
For the first field, in this case MARC Date Edited, enter the
starting and ending values for the range. In this example, enter
7/11/2000 in the Start at box and 9/25/2000 in the End at
box.

5 For the second field, in this case Author, enter the starting and
ending values for the range. In this example, enter A in the
Start at box and D in the End at box.

6 Click OK to save the range and close the window.
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Selecting an output file
You have to specify the destination of the exported files. You can enter the path and file
name of the destination file in the "Output file" of the Material Export window, or you
can select the output file by clicking the Browse button and locating it yourself.

How to select an output file
Example scenario: You want to save the exported records in a file called export.004.

To select the file to export
1 In the Material Export window, click Browse. A window opens

for you to locate and select the file you’re exporting to. If you’re
exporting to a floppy disk, make sure the disk is inserted.

2 In the File name box, enter the name of the file, in this case
export.004.

3 Click Save. The window closes, and the file name you selected
is automatically entered into the Output file box.

If the folder in which you want to save the export file does not exist, you can create it
from the window that opens after you click the Browse button.

Starting the export
Once you have specified the records that you want exported, the export format, and the
output file, you can start the export.

How to start the export
Example scenario: You have already started the Material Export feature and specified the
records you want exported, the export format and the output file. Now you are ready to
start the export.

To start the export
In the Material Export window, click Export.
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Stopping or pausing the export
After you begin exporting, you can temporarily pause or permanently stop the process.

How to pause and stop the export

To pause the export
In the Material Export window, click Pause. The program
temporarily halts the export. (Click Export to resume importing.)

To resume the export after pausing
Click Export.

To stop the export (and stay in Material Export)
1 In the Material Export window, click Pause.

2 Click Stop. The program stops exporting records but leaves the
Material Export window open.
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Batch processing material records

You can use the batch process feature to change information in your material records.
The phrase "batch process" refers to the action of modifying groups of records in your
database. You can use this feature to make the following modifications to groups of
material records:

• Add, edit, or clear data such as material user-defined data or call
number data.

• Clear regular usage and in-library usage.

• Reassign material types (by matching call number patterns). Note:
When the program reassigns material types, it checks for materials
that are on special reserve. If a material is on special reserve, the
original type of that material changes.

• Change inventory (lost) status, which essentially decreases the number
of periods that a material has been marked lost. If the number
becomes zero, the material’s status changes from "lost" to "in."

• Delete entire material records. Note: Materials that are checked out,
reserved, or have fines or messages are not deleted.

You can batch process all of your records, records in a selected range, records that meet
certain conditions, or records in a selected range that meet certain conditions. You can
even create a text file listing the records that you want to process. If you do, the program
will process only the records listed in the file.

Note: If you have Windows 98 or Windows 2000 on your client computer, make sure that
Power Management is not turned on while you batch process on the computer. If Power
Management shuts down your computer during the batch process, your database could
become corrupt. You can access Power Management through the Control Panel. While
you batch process, you should also turn off any other program, such as a screen saver,
that shuts down or suspends activity on your computer.

Backing up
Back up your database files before and after you make major changes to your records.
For more on backups, see "Backing up Spectrum data" in the Backup chapter of this
manual.
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How to start Material Batch Processing

To start batch processing
1 From the Navigator toolbar, click the Materials button and

choose Batch Process.

The Material Batch Processing window opens, which provides
an overview of the material batch process.

2 View the basic steps of the batch process.
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3 Click Next to continue. The Range window opens.

The batch process feature has a "wizard" look—which guides you through each step of a
multi-step process. It offers helpful information and explains options along the way.
Follow the instructions in the windows, and use the Back and Next buttons to navigate
through the windows. Click Exit in any window to cancel the batch process.
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Understanding batch process steps
When you first start the Batch Process feature, an introductory window opens that
explains the four basic steps involved in batch processing your material records.

Here is a description of the various windows you encounter when batch processing. Each
window corresponds to a step in the batch process.

Window Description

Range Lets you set the range of records to process. The batch process
won’t necessarily modify all of these records. However, while
processing, the program only inspects these records.

Conditions (This step is optional.) Lets you set the conditions, if any, for
the records to process. By specifying one or more conditions,
you identify the particular characteristic(s) of the records to be
modified. Only those material records in the range that meet the
condition(s) set in this step are modified.

Actions Lets you set the modification(s) to be made. Here you specify
how you want to change the records in the range that meet the
condition(s).

Finalize Lets you verify the settings of your batch process before you
start processing.

Step 1: Specifying the records to process
The first step in batch processing is to specify the records that you want processed. You
can do this by specifying a range of records. You can also create a file containing a list of
material numbers. Once the list is complete, you can have the program batch process only
those records listed in the file.

You specify records in the Range window. For more information about the Range
window, see "About the Range window" in the Materials chapter of the Spectrum
CIRC/CAT Reference Manual.
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Specifying a range of records
If you have a lot of records in your database and don’t need to change them all,
specifying a range of only the records you need to process can substantially reduce batch
processing time. All the materials in this range may not be modified; however, all these
records are inspected to find those that do require processing, according to the criteria
you set up.

Initially, the range is set to include all of your material records. However, you can narrow
the range to best meet your needs.

How to specify a range
Example scenario: You want to batch process only those records with material types 1, 2,
and 3.

To specify a range of records
1 In the Range window, in the Field box, select the field on which

you want to base your range. In this case, choose Material
Type.

2 Enter the starting and ending values of the range. In this case,
type 1 in the Start at box and type 3 in the End at box.

3 Click Next to continue.

You can specify a single material type by entering the same material type value in both
the Start at and End at boxes. Similarly, if you are specifying a range based on a field
such as material number, you can have the program process a single record by entering
the record’s material number in both boxes.

Note: If you base your range on either Title or Author, you can click the Set Tags button
to select the title or author tag numbers to process. For more information, see "Specifying
MARC tags to process" later in this chapter.
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Selecting materials from a file
You can create a text file of material numbers and have the program batch process only
records listed in this file. You can use NotePad, SimpleText, or similar program to create
the file.

The file must be structured so that there is only one material number per line with no
additional characters. All numbers listed in this file are assumed to be from the location
chosen in the Range window.

How to select materials from a file
Example scenario: You have already created a file called batch.001 that contains a list of
material numbers for the records you want to process. Now you want to tell the program
to use this file to determine which records should be processed.

To select material records from a file
1 In the Range window, select Material number (from a file)

from the Field box.

2 Click Select File.

3 In the Open window, locate and select the file that contains the
material records, in this case batch.001.

4 Click Open. The name of the selected file is displayed in the
Range window next to File name.

5 Click Next to continue.

Specifying MARC tags to process
When you select some fields (such as the Title and Author fields) for your range,
condition, or action, you can click the Set Tags button to select the tag numbers
containing the field information you want to process.

You should select the specific tags to process because MARC cataloging stores some
data (like title and author information) in a variety of subfields. For example, besides
having a tag that holds the main title information (tag 245), a book may also have series
title information (tag 440).

The Set Tags button is available in the Range, Add Condition, Edit Condition, Add
Action, and Edit Action windows, when appropriate.



300 Spectrum CIRC/CAT User Manual
SCC5um1200kh

How to select tags
Example scenario: You want to process the items for records that have an author name
that falls within a specific range. You want the program to consider all author tags when
determining if a record should be processed.

To select a tag to batch process
1 In the Range window, in the Field box, choose Author.

2 Click Set Tags. A window opens in which you can choose the
tag fields to process (the tag window displayed depends on the
field you select).

3 Select or deselect the appropriate tag fields. In this case, select
All tags.

4 Click OK. The selected tags are displayed in the window.

For more information about the Tags windows, see "About the Title Tags window" and
"About the Author tags window" in the Materials chapter of the Spectrum CIRC/CAT
Reference Manual.

Although this example uses the Range window, you can use the same process to select
tags in the Add Condition, Edit Condition, Add Action, and Edit Action windows.
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Step 2: Setting batch process conditions
When you set batch process conditions, only those records that have certain
characteristics, such as a certain price or location, are processed. The program won’t
modify any records in your range that don’t meet your condition(s). For example, you
may want to change only the records you added to the database after January 1, 1998. In
this situation, you could use a condition to process only the records added after that date.
These conditions work in conjunction with the range you set in the Range window.

You don’t need to set conditions to batch process your records. If you don’t want to set
conditions, click the Next button in the Conditions window to continue.

You can set up to five conditions for the batch process.

Adding, editing, and removing batch conditions
When you click Add or Edit in the Conditions window, the Add Condition window or
Edit Condition window opens. You use these windows to enter the details of a condition.
Remember, the batch process modifies only those materials that meet the condition(s)
specified, if any.

You can add, edit and delete conditions.



302 Spectrum CIRC/CAT User Manual
SCC5um1200kh

How to add a condition
Example scenario: You want the program to batch process only those records that have
the author "Martan, Louise". This is the only condition that you want to specify.

To add a batch process condition
1 In the Conditions window, click Add. The Add Condition

window opens.

2 Select a field from the Condition field box. In this case, choose
Author.

3 Select a condition from the Condition box. In this case, choose
is equal to.

4 Enter the condition value in the Condition value box. In this
case, enter Martan, Louise.

5 Click Next.

You can now set the options for this condition. For more information, see “Setting
options for batch process conditions”. For more information about the Add Condition
window, see "About the Add and Edit Condition windows" in the Materials chapter of
the Spectrum CIRC/CAT Reference Manual.

Note: With some fields, you cannot set condition options. If so, instead of a Next button,
you will see a Save button.

Also, when you choose either Title or Author as the Condition field, you can click the Set
Tags button to select the title or author tag numbers to process. For more information, see
"Specifying MARC tags to process" earlier in this chapter.
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You may notice that two fields in the Condition field list have similar names “location”
and “location code”. “Location” refers to the shelving location within a library. “Location
code” refers to a library within your district.

Setting options for batch process conditions

Sometimes when you set batch process conditions, you need to set options for those
conditions. When you click Next in the Add Condition or Edit Condition windows, the
Condition Options window is displayed. Note: This window opens only if you can further
define the value(s) entered for the condition.

The condition options compare the condition value(s) you enter with the values in the
selected field for all the material records in the specified range. For example, you may
add a condition that processes material records with call numbers that begin with
numbers greater than 233. You need to click the Next button in the Add Condition or Edit
Condition window to set options for that condition. You would then select Numeric as
your condition option, because the condition value—233—is a number.

You don’t need to specify options for every condition you set. Depending on what you
select from the Condition box of the Add Condition window or the Edit Condition
window, you see either a Next or a Save button. The Next button takes you to the
Condition Options window. The options displayed depend on what condition you select
in the Condition box.

For information about the Condition options window, see "About the Condition Options
window" in the Materials chapter of the Spectrum CIRC/CAT Reference Manual.
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How to set condition options
Example scenario: You have set up a condition that specifies that Author values must be
equal to "Martan, Louise". The program allows you to specify two options for this
condition: "Case-sensitive" and "Ignore punctuation". You want to specify that the
condition be case-sensitive, and that the program ignore punctuation.

To set options for a condition
1 If you have not already done so, click Add in the Conditions

window and specify the condition. Then click Next. The
Condition Options window opens.

2 Choose the desired options. In this case, select both Case-
sensitive and Ignore punctuation.

3 Click Save. The program returns you to the Conditions window.
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How to edit a condition
Example scenario: You have already set a condition specifying that Author values should
be equal to "Martan, Louise". Now you realize that you misspelled the author’s name.
You want to change this condition to specify that values be equal to "Marten, Louise".

To edit a batch process condition
1 In the Conditions window, select the condition you want to edit

from the list of existing conditions.

2 Click Edit. The Edit Condition window opens.

3 Make the necessary changes. In this case, in the Condition
value box, type Marten, Louise.

4 Click Next.

You can now set the options for this condition. For more information, see "Setting
options for batch process conditions" later in this chapter. For more information about the
Edit Condition window, see "About the Add and Edit Condition windows" in the
Materials chapter of the Spectrum CIRC/CAT Reference Manual.

Note: With some fields, you cannot set condition options. If so, instead of a Next button,
you will see a Save button.

Also, when you choose either Title or Author as the Condition field, you can click the Set
Tags button to select the title or author tag numbers to process. For more information, see
"Specifying tags to process" earlier in this chapter.



306 Spectrum CIRC/CAT User Manual
SCC5um1200kh

How to remove a condition
Example scenario: You have specified a condition and now realize that it is not needed.

To remove a condition
1 In the Conditions window, select the condition you want to

remove

2 Click Remove.

Using multiple conditions and Boolean operators
When creating a batch process, you can set more than one condition. When adding a
second or subsequent condition, you must include a Boolean operator (AND or OR) so
that the program knows how to apply the multiple conditions. These options are both
available in the Add Condition window whenever you add multiple conditions.

Step 3: Setting batch process actions
When you click Next in the Conditions window, the Actions window opens.

For information about the Actions window, see "About the Actions window" in the
Materials chapter of the Spectrum CIRC/CAT Reference Manual.
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In the Actions window, you can open the Add Action and Edit Action windows. In the
Add Action or Edit Action window, you select the action to be done, the field to apply
the action to, and how the field is to be changed. You can define up to five
modifications—depending on the actions that you select (if you choose to delete, no
additional modifications are allowed). When you have finished, you should be able to
read your settings like a sentence. For example, an action might read "Replace the field
Author with King, Stephen."

After at least one action is entered, the range options are not available to modify in the
Range window until you remove all actions.

How to add an action
Example scenario: Some records in your library have the author listed as "Marten,
Louise" instead of "Martin, Louise". You have already specified the range and condition
necessary to process these records. Now you want to specify an action that changes the
contents of the author fields to "Martin, Louise".

To add a batch process action
1 Click Add in the Actions window. The Add Action window

opens.

2 Select an action to perform from the Action box. In this case,
choose Replace the field.

3 Select a field from the Field box. In this case, choose Author.

4 Select a modifier from the Modifier box. In this case, choose
with.
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5 Enter the appropriate information in the Value box. In this case,
type Martin, Louise.

6 Click Save.

Note: If you choose either the Title or Author field, you can click Set Tags to select the
title or author tag numbers to process. For more information, see "Specifying tags to
process" earlier in this chapter.

How to edit an action
Example scenario: You have already entered an action and now realize that you need to
change it.

To edit a batch process action
1 Select the action you want to edit from the list of actions in the

Actions window.

2 Click Edit. The Edit Action window opens.

3 Make the necessary changes.

4 Click Save.
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How to remove an action
Example scenario: You have already entered an action and now realize that it is no longer
needed.

To remove a batch process action
1 In the Actions window, select the action that you want to

remove.

2 Click Remove.

Step 4: Verifying batch process settings
When you click Next in the Actions window, the Finalize window opens.

All of the batch process settings appear in the Finalize window. For more information
about the Finalize window, see "About the Finalize window" in the Materials chapter of
the Spectrum CIRC/CAT Reference Manual.

Before you click the Process button to begin the batch process, carefully look over your
options to make sure that you chose the correct range, conditions, and actions. If the
options aren’t correct, you can return to the previous windows to change them.
Remember, if actions exist, the range options are unavailable for modification until you
remove the actions.
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Step 5: Starting the batch process
Once you have verified that all your settings are correct, you can start the batch process.

To start the batch process
1 Review the options in the Finalize window. (If the current batch

process options aren’t correct, you can change them by clicking
Back or cancel the entire process by clicking Exit.)

2 Click Process to start the batch process (click Stop to cancel the
process). When the batch process is done, an information
window informs you that the process is complete. (If an action
cannot be performed on one or more records, you are informed
of the reason.)

3 Click OK.

To start another batch process, click Start Again. To exit the batch process function, click
Exit.
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Creating material custom indexes

In Spectrum CIRC/CAT, your material database is automatically indexed by some
material fields, so that you can sort your records by these fields. You can also create and
save your own indexes. These custom indexes can be based on a single field or on
multiple fields. You can even combine fields from both MARC and holding data. When
new material records are added to the database, all existing custom indexes are
automatically updated to include the new records.

Once you have created an index, you can use it when exporting materials and printing
reports, just as you would a standard index. For example, if you are ordering books, you
might create an index sorted by call number, publisher, and title, and then print a report
based on this index. Or, to create a report of new books, you could create an index based
on the date added, call number, and title fields. Later when generating the report, you
could sort and limit it based on this index.

Opening Material Custom Indexes
To open Material Custom Index

From the Navigator toolbar, click the Materials button and
choose Custom Indexes.
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The Material Custom Indexes window opens.

Material Custom
Indexes window
If there are no
existing custom
indexes, the Index
Name fields are blank
and all First, Second
and Third Field values
are set to None.

For information about the Material Custom Indexes window, see "About the Material
Custom Indexes window" in the Materials chapter of the Spectrum CIRC/CAT Reference
Manual.

Creating and editing material custom indexes
To create or edit a material custom index, you enter an index name, select the appropriate
fields and have the program build the index. If the index already exists, the program
informs you and confirms that you want to rebuild the index.

How to create or edit a material custom index
Example scenario: You want to create an index called "AUTHOR DATE" that first sorts
by author name and then sorts by date added. In other words, you want records arranged
by author. However, if several records have the same author name, you want that group
of records further sorted by date added.

To create or edit a material custom index
1 From the Navigator toolbar, click the Materials button and

choose Custom Indexes. The Material Custom Indexes window
opens.

2 Enter the name of the material custom index in the Index
Name box. In this case, type AUTHOR DATE. Notice that the
characters are displayed in capital letters.
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3 Select the fields to be indexed by in the First Field, Second
Field, and Third Field boxes. (If you don’t use a field, select
(None) in its box.) In this case, choose Author for the First
Field; choose MARC Date Added for the Second Field; choose
(None) for the Third Field.

4 To check whether the material files are in use, click Check for
Users. The Check for Users window opens, informing you
whether other users are using the material files. You cannot
build a custom index while the material files are in use.

5 Click Build. The Build Material Custom Indexes window opens
and shows the progress of the build process.

6 When the window indicates that the custom index is complete,
click Close.

Note: If you stop the build process, the index is not built. To build it, you must restart the
process. (If you don’t explicitly build a custom index, the index files are created the next
time a program opens them, so they show up on your hard disk, but they won’t have
useful information in them.)

After building the index, it is displayed in the Material Custom Indexes window.

Material Custom
Indexes window
After you build a
custom index, the
index name and fields
are displayed in the
boxes.
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Renaming material custom indexes
You can rename a material custom index without having to rebuild the index.

How to rename a material custom index
Example scenario: You have already built a material custom index called "AUTHOR
DATE". Now you want to change the index name to "AUTHOR BY DATE ADDED".

To rename a material custom index
1 From the Navigator toolbar, click the Materials button and

choose Custom Indexes. The Material Custom Indexes window
opens showing all existing custom indexes.

2 For the index you want to change, enter the new name in the
Index Name box. In this case, enter AUTHOR BY DATE ADDED.

3 Click Build. The program informs you that only the name
changes.

4 Click OK.

Removing material custom indexes
If you no longer need a particular material custom index, you can remove it from the
system.

How to remove a material custom index
Example scenario: You have previously created a material custom index called
"AUTHOR BY DATE ADDED". You no longer need this index and now want to
remove it.

To remove a material custom index
1 From the Navigator toolbar, click the Materials button and

choose Custom Indexes. The Material Custom Indexes window
opens showing all existing custom indexes.

2 For the index that you want to remove, in this case AUTHOR BY
DATE ADDED, delete the name of the material custom index
from the Index Name box.

3 In the First, Second, and Third Field boxes, select (None).

4 Click Build. The Build Material Custom Indexes window opens.

5 When the custom index is removed, click Close.
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Using material custom indexes
You can use material custom indexes when exporting material records and when printing
reports. When performing these activities, your custom indexes can be selected from the
Index box. You will notice that custom index names are always displayed in capital
letters.

When exporting records or printing a report, if you select a material custom index, the
default custom index range is displayed. The Change Custom Index Range button is also
enabled. When you click this button, the Custom Index Range Selection window opens,
so that you can use the index to specify a range. To help you do this, the Custom Index
Range Selection window lists the field(s) the index is built on, and lets you specify a
range for each. The first index field defaults to the lowest and highest values in the
database so all records are initially included in the range. The second and third index
fields, if available, are blank by default.

For example, you might want to create a list of new books that were added to your
database within the past year. You could create a custom index to sort your material
records by date added, call number, and title. Later, when you print the report, you could
choose this index and specify the appropriate range of dates.

For more information on using material custom indexes, see "Exporting material records"
earlier in this chapter and "Selecting a custom index range" in the Reports chapter of this
manual.
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Editing subjects globally

Because of data entry errors, there may be several variations of the same subject in your
database. The Global Subject Edit feature allows you to find and fix subject variations, so
that only the correct subject is used.

Opening Global Subject Edit

To open Global Subject Edit
From the Navigator toolbar, click the Materials button and
choose Global Subject Edit.

The Global Subject Edit window opens and displays a list of all
subjects in your database. You can use the scroll bar and the up
and down arrow keys to view more of the list.
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For information about the Global Subject Edit window, see "About the Global Subject
Edit window" in the Materials chapter of the Spectrum CIRC/CAT Reference Manual.

What are subject variations?
Subject variations are subjects that are alike except for punctuation or capitalization. For
example, the following are subjects of three different materials:

_aAustralian Inventors_xBiography_xJuvenile Literature

_aAustralian Inventors_xBiography_xJuvenile Literature

_aAustralian Inventors_xBiography_xJuvenile Literature.

As you can see, the first two subjects are identical. The last subject ends with a period, so
it is a variation of the first two. However, when determining variations, the program
checks only the first 48 characters. If one or more of the subjects are longer than the 48
character limit, the program assumes that they are variations. In this example, the subjects
are longer than 48 characters. Therefore, the program assumes that all three are variations
of the same subject. Since this may not actually be the case, the program indicates that
the number of variations is an estimate.
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In the Global Subject Edit window, the subject is displayed as:

(3) * _aAUSTRALIAN INVENTORS_xBIOGRAPHY_xJUVENILE LITE

Note: The "3" refers to the number of subject variations. The asterisk indicates that the
number of variations is an estimate. In the case of an estimate, you can check to see if
there really are variations by viewing the subject details. For more information, see
"Viewing subject details".

Viewing subject details
You can view subject details when you want to see the different variations of a particular
subject and determine how many times the variation occurs in your database. When
displaying subject details, the program shows the subjects as they currently exist in the
database—with no changes to the punctuation and capitalization. The program also
includes all subfields.

Note: You can select various subject variations and globally change them to make them
all the same. For more information, see "Changing subjects" later in this chapter. If a
subject exceeds 150 characters, you cannot change it in Global Subject Edit. However,
you can change it in the Material Edit part of the program. For instructions, see "Editing
existing material records" earlier in this chapter.

How to view a subject's details
Example scenario: The Global Subject Edit window shows that there are two variations
of the subject a_TEXAS_x_HISTORY. You want to see each variation and learn now
many times it occurs in your database.

To view subject details
1 From the Navigator toolbar, click the Materials button and

choose Global Subject Edit. The Global Subject Edit window
opens.

2 In the Subjects list, select the subject, in this case
a_TEXAS_x_HISTORY.
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3 Click Details. The Subject Details window opens and shows the
subject variations for the selected subject. The number to the
left of the variation indicates how many times it occurs in the
database.

For information about the Subject Details window, see "About the Subject Details
window" in the Materials chapter of the Spectrum CIRC/CAT Reference Manual.

Changing subjects
There are two methods of globally changing subjects:

• Browsing through a list of existing subjects and selecting one as an
authority subject. The program then replaces all other selected
variations with the one you specify as the authority subject. For
instructions, see "Using authority subjects".

• Manually entering a subject (or editing a "master subject"). The
program then replaces all selected subject variations with the subject
you entered. For instructions, see "Using a manually entered subject
for global changes" later in this chapter.

Note: If a subject exceeds 150 characters, you cannot change it in Global Subject Edit.
Instead, you should use Material Edit. For instructions, see "Editing existing material
records" earlier in this chapter.

The Global Subject Edit process also searches for and removes duplicate tags, indicators,
and subfields within the same MARC record.
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Using authority subjects
An authority subject is a subject in your database that you use to replace incorrect subject
variations. For example, if you have three variations of the same subject, you could
choose one as the authority subject and use it to replace the other two variations.

You can browse through the list of existing subjects and select one to use as the authority
subject. Or, instead of browsing, you can search for a specific subject. Once you have
chosen the authority subject, the program replaces all selected variations with the
authority subject.

How to use an authority subject
Example scenario: The Global Subject Edit window shows that there are three variations
of the subject _aALASKA_xFICTION._2SEARS. You want to use the authority subject
method to change all variations to _aAlaska_xFiction._2sears. (This variation of the
subject does occur in your database.)

To use an authority subject
1 In the Global Subject Edit window, select the subject

_aALASKA_xFICTION._2SEARS and click Details. The Subject
Details window opens.

2 In the Subject variations list, select the subject variation(s) that
you want to change. In this case, choose all variations except
_aAlaska_xFiction._2sears. (To select or deselect a variation, click
it.)

3 Click Select Authority Subject. The Select Authority Subject
window opens.
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4 Locate the subject that you want to use as the authority subject.
(You can type the first few characters in the Search for box to
have the program move to the first subject that matches the
characters you enter.)

Or, you can use the scroll bar to browse for the subject.

Note: The Select Authority Subject window displays subjects as
they currently exist in the database—with no changes to the
punctuation and capitalization—and includes all subfields.

5 In the Available authorities list, select the subject that you
want to use as the authority subject. In this case, select
_aAlaska_xFiction._2sears.

6 Click Select. The Confirm Subject Change window opens to
confirm that you want to change the selected subject(s).

7 Click Yes.

For information about the Select Authority Subject window, see "About the Select
Authority Subject window" in the Materials chapter of the Spectrum CIRC/CAT
Reference Manual.
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Using a manually entered subject for global changes
You can also enter a subject manually, and have the program change all selected
variations to the subject you enter. You can enter a subject by typing it or by choosing an
existing subject (master subject) and editing it.

Once you have entered the subject, the program replaces all selected variations with the
subject you entered.

How to use a manually entered subject for global changes
Example scenario: The Global Subject Edit window shows that there are three variations
of the subject _aALASKA_xFICTION._2SEARS. You want to use the manual method to
change all variations to _aAlaska_xFiction._2sears. (This variation of the subject does
not occur in your database.)

To change subject variations
1 In the Global Subject Edit window, select the subject

_aALASKA_xFICTION._2SEARS and click Details. The Subject
Details window opens.

2 In the Subject variations list, select the subject variation(s) that
you want to change. In this case, select all variations. (To select
or deselect a variation, click it.)

3 Click Change. The Change Subject(s) window opens.
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4 In the Selected subject(s) list, select a master subject that you
can easily change to the desired subject. In this case, choose
the subject that is closest to _aAlaska_xFiction._2sears. The
program enters this subject into the Change selected
subject(s) to box.

5 Edit the subject in the Change selected subject(s) to box. In
this case, change it to _aAlaska_xFiction._2sears.

6 Click Change. The Confirm Subject Change window opens to
confirm that you do want to change the selected subject(s).

7 Click Yes. The Subject Change Progress window opens and
displays the progress of the global change.

You can click Stop to end the process, Pause to pause the process, and Continue to start
it again.

Note: You cannot enter invalid characters in the Change Subject(s) window. Invalid
characters are the caret ( ^ ) and the grave accent mark ( ` ). You also must enter subfields
correctly; the subfield delimiter ( _ ) must be followed by a lowercase letter or a number.

For information about the Change Subject(s) window, see "About the Change Subject(s)
window" in the Materials chapter of the Spectrum CIRC/CAT Reference Manual.
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